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Abstract 

While the regulatory mechanisms of chemokines in orchestrating adaptive and innate im-

mune responses have been extensively elucidated, the contributions of biophysical me-

chanical cues to the modulation of immune cell migratory behaviors remain largely unex-

plored. In this study, we applied a modular co-culture experimental system, pairing sus-

pension Jurkat T lymphocytes (with RAW 264.7 macrophages as a positive migratory con-

trol) with two distinct force-generating cell types—human airway smooth muscle cells 

(ASMCs) and human lung adenocarcinoma A549 cells—cultured on 1 mg/mL type I col-

lagen hydrogels, to dissect the regulatory effects of intercellular mechanical signals on the 

directional migration of immune cells. We observed that Jurkat T cells exhibited robust, 

targeted directional migration toward force-generating cells on the 2D hydrogel surface, 

with migratory trajectories consistently oriented toward mechanically active target cells. 

Glutaraldehyde-mediated crosslinking of collagen matrix or higher-stiffness ~5 mg/mL 

Matrigel supplemented with 0.5 mg/mL collagen, which ablates cell-cell mechanical inter-

actions, significantly impaired the directional attraction of immune cells, confirming the 

role of mechanotaxis in this migratory phenotype. Notably, Jurkat T cell migratory effi-

ciency depended on the identity of force-generating cells, with enhanced directional mi-

gration toward ASMCs relative to A549 cells, a phenotype likely driven by cell type-spe-

cific intrinsic mechanical properties. Furthermore, 3D encapsulation within bulk collagen 

hydrogels significantly attenuated Jurkat T cell directional migration toward both force-

generating cell types, relative to the 2D hydrogel platform. Collectively, our data demon-

strate that T cell mechanotaxis is dually modulated by the intrinsic mechanical phenotype 

of force-generating cells and the dimensionality of the extracellular matrix microenviron-

ment. These findings establish that biophysical mechanical cues, independent of and com-

plementary to canonical chemokine gradients, are potent regulators of directional T cell 

migration, providing novel mechanistic insights into the emerging field of immunome-

chanics. 
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1. Introduction 

Cell mechanical communication has emerged as a key research frontier, encompass-

ing cell-cell mechanical interactions, cell-extracellular matrix (ECM) mechanical crosstalk, 

and mechanosensitive channel signaling. These processes control fundamental immune 

functions and disease progressions. In recent decade, a variety of molecular and signaling 

pathways related to mechanical communication have been elucidated. At the immune 

synapse, T cells bind to ICAM-1 of target cells through LFA-1, transmitting mechanical 

signals to enhance immune responses[1]. When ECM stiffness is increased, mechanical 

tension inhibits the Hippo pathway, promoting YAP/TAZ nuclear translocation and fi-

brotic or tumorigenic gene expression[2]. The mechanosensitive ion channel Piezo1 con-

verts mechanical forces into biochemical signals to drive tumor angiogenesis [3]. Many 

mechanical signaling pathways affect the mechanical communication of cells. 

Chemokines are important regulatory factors in immune response. In most theories, 

the directional aggregation of immune cells depends on chemical factors, namely chemo-

kines. CCL19 and CCL21 are involved in immune surveillance by directing T cell migra-

tion to lymph nodes through the receptor CCR7[4]. On the surface of endothelial cells at 

sites of inflammation, LFA-1 mediates T cell adhesion and crawling on blood vessels for 

transendothelial migration[5]. CX3CR1, a receptor for the chemokine CX3CL1, plays an 

important role in the regulation of inflammatory responses, including monocyte homeo-

stasis and macrophage phenotype and function[6].  

Mounting evidence indicates that immune cells are also regulated by mechanical 

cues. Fluid shear stress enhances NK cell cytotoxicity against circulating tumor cells 

through NKG2D-dependent mechanosensing [7]. CD8⁺ T cells sense substrate stiffness via 

Piezo1, and excessive stiffness induces CD8⁺ T-cell exhaustion [8]. Memory B cells exhibit 

high sensitivity to mechanical forces, whereas naive B cells display a threshold-dependent 

mechanosensory response relying on Myosin IIA and integrins [9]. These findings high-

light the dual control of immune cells by chemical and mechanical signals. 

Despite advances in cancer immunotherapy, the mechanistic basis underlying 

force-modulated immune responses remains poorly defined. Piezo1 deficiency alleviates 

lung inflammation in bacterial infection models[10]. Mechanically sensitive immune cells 

are activated to different degrees by different mechanical signals[11]. Some immune cells 

are sensitive to mechanical stimuli and matrix stiffness and thus affect the immune re-

sponse[12]. Mechanical cancer therapies such as focused ultrasound (FUS) trigger im-

mune activation through thermal and mechanical effects, enhancing vascular permeabil-

ity, T-cell infiltration, and tumor suppression[13]. Engineered ultrasound-responsive T 

cells further highlight the translational potential of mechanoimmunotherapy[14]. With 

the development of various researches, mechanoimmunotherapy will become more and 

more important. 

Macrophages play a central role in immune responses by secreting pro-inflammatory 

cytokines (e.g., IL-6, TNF-α) to recruit immune cells to inflammatory foci[15]. Integrin-

ECM adhesion signals initiate signaling pathways that affect macrophage activation[16]. 

Increased matrix stiffness leads to upregulation of Piezo1 expression and activation of the 

mechanotransduction effector YAP, which regulates macrophage polarization[17]. Mac-

rophages can track cancer cells via collagen-transmitted mechanical signals, likely because 

cancer cells generate stronger mechanical cues via enhanced motility and ECM remodel-

ing[18]. However, whether mechanical signals direct the migration of suspension immune 

cells remains unclear. 

In this study, we applied a collagen hydrogel-based model to dissect the effects of 

mechanical cues (using airway smooth muscle cells and lung cancer cells as force sources) 

on the directional migration of suspension immune cells, using Jurkat T cells as a para-

digm and macrophages RAW264.7 as a positive control. We show that mechanical cues, 
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in addition to the traditional chemotactic factors that drive cell migration, are also effec-

tive in guiding T cell directional migration. These findings revise the classical chemo-

kine-centric model of immune cell migration and provide a theoretical foundation for in-

tegrating mechanical immune regulation with chemotherapy. 

2. Materials and Methods 

2.1. Cell culture and regents 

Human airway smooth muscle cells (hASMC), Jurkat T cells, human lung cancer cells 

A549, and murine macrophages RAW264.7 were purchased from BeiNa Biology. All types 

of cells were cultured in mediums supplemented with 10% fetal bovine serum (FBS), 100 

U/mL penicillin, and 100 g/mL streptomycin. hASMC cells were maintained in low glu-

cose-type DMEM medium, Jurkat T cells in RIPM 1640 medium, A549 in F12 medium, 

and RAW264.7 in high glucose DMEM medium. Cells were cultured in a humidified cell 

incubator containing 5% CO2 at 37C. Jurkat T was cultured on a mini-shaker (~20 rpm) 

to maintain suspension growth within the incubator. 

All cell culture mediums, FBS, Lipofectamine 3000, and Opti-MEM were purchased 

from Thermo Fisher Scientific (Waltham, MA, USA). Rat type-I collagen was from Ad-

vanced Biomatrix and MatrigelTM from BD Biotechnology (CA, USA). Cytochalasin D 

(Cyto D) was from Sigma-Aldrich. 

2.2. Constructing hydrogel model for two-type cell-cell mechanical interactions 

To describe the experimental scheme, hAMSC was used as the force-generating cells 

and Jurkat T was used as the experimental immune cells. hAMSC cells had larger size 

than Jurkat T, and to further distinguish them under the microscope imaging, Jurkat T 

was stained with live cell dye CellTracker Red. All procedures were performed on ice. f 5 

mL. To make polydimethylsiloxane (PDMS), the two liquid components from the Sylgard 

184 kit (Dow Corning) were well mixed at a 10:1 mass ratio in a petri dish followed by 

curing at 70°C. A PDMS mold (inner diameter ≈1 cm, outer diameter ≈1.5 cm, thickness ≈2 

mm) was attached onto the glass bottom of a confocal dish. Rat-tail type I collagen (3.9 

mg/ml) was mixed with neutralizing buffer in a 9:1 ratio, and diluted to 1 mg/mL with 

PBS solution. The prepared collagen solution was added into the PDMS ring by using a 

10 l pipette, and spread several times until the inner plane of the ring was covered evenly. 

Then, the hydrogel model was incubated at 37°C for 15 min to allow gelation.  

Jurkat T cells were stained with CellTracker Red: 3 mL of the cells from suspension 

culture were centrifuged, resuspended with 2 ml of serum-free RIPM 1640 medium con-

taining 5 μl of CellTracker Red, and then incubated in the cell culture incubator for 30 min. 

After centrifugate, cells were adjusted to 5106/ml in complete RIPM 1640 medium. 

hASMC cells were trypsinized, and diluted to 1105 cells/mL. 20 l hASMC cell suspen-

sion was seeded onto the collagen gel evenly within the PDMS ring, and then the dish was 

placed within a six-well holder (Karl Zeiss) and incubated for 1 h to allow cell attachment. 

Then, 20 l of stained Jurkat T suspension was added and incubated for another 1 h. a 1:1 

mixture of RIPM 1640 medium and low-sugar DMEM medium (10% FBS) was made for 

hASMC and Jurkat T co-culture in experiments. 2 mL of the mixture medium were added 

gently along the dish edge without disturbing the cells, and samples were subjected to 

time-lapse imaging in the live cell microscope workstation.  

Four cell interaction pairs were tested: Jurkat T + hASMC, Jurakt T + A549, RAW264.7 

+ hASMC, RAW264.7 + A549, by following the similar preparations. As inert negative 

controls, magnetic beads (~5 m in diameter) were added at similar density to replace the 

immune cells. For 3D collagen embedding experiments, immune cells were mixed with 
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collagen solution (1 mg/mL) and overlaid on collagen gels pre-seeded with force-generat-

ing cells (hASMC or A549), followed by gelation for 15 min and medium addition. 

2.3. Glutaraldehyde crosslinking of the hydrogel 

Glutaraldehyde crosslinking of the hydrogel can reduce traction force transmission 

through the matrices, which served as a negative condition in this work. Briefly, the 1.0 

mg/mL collagen hydrogel was treated with 0.05% glutaraldehyde solution for 15 minutes 

and then neutralized with Tris-HCl solution for 1 hour, followed by three times of PBS 

buffer washings (5 min each time). The method hereafter is the same for two-type cell 

seedings.  

Alternatively, to mimic in vivo basement membrane matrices, the experimental con-

dition was examined on the hydrogel of 50% Matrigel (~5 mg/mL) supplemented with 1.0 

mg/mL type I collagen (COL). To compare with the untreated normal condition, the“Mat-

rigel + COL” hydrogel was crosslinked with 0.05% glutaraldehyde solution, or the force-

generating cells hASMCs were pre-treated with Cyto D (1.0 g/mL) for 1 h to reduce cell 

contraction force. The co-culture of hASMC and Jurkat cells were also seeded on glass 

surface coated with 1.0 % “Matrigel + COL” diluted solution, as non-traction force trans-

mission control. 

2.4. Live cell microscope imaging 

Time-lapse imaging was carried out on a Zeiss observer.Z1 live-cell workstation 

equipped with a temperature- and CO₂-controlled chamber (37°C, 5% CO₂). The cell sam-

ple dishes were placed into a six-well holder within the chamber. Images were acquired 

at 1 h intervals for 36 h. Stained Jurkat T cells were visualized using a Rhodamine channel. 

2.5. Cell Trajectory Tracking and Analysis 

Time-series images were imported into ImageJ. Scale calibration was performed via 

Analyze > Set Scale by clicking the Straight Line, and then Set Scale in the Analyze column 

to convert visual distance to real size. Cell migration was tracked using Plugins > Manual 

Tracking to generate coordinate data by using Add track frame by frame to obtain cell 

trajectory results. The digital data files were imported into MATLAB 2015b software to 

determine the move rate, velocity, trajectory, and travel distance as described previously 

(reference).  

2.6 Statistical Analysis 

Data were analyzed and plotted using GraphPad Prism, and Origin2020. Values are 

presented as mean ± standard deviation (S.D.). Student’s t-test was used for two-group 

comparisons; one-way ANOVA for multiple groups. *p < 0.05, **p < 0.01, ***p < 0.001, 

and ****p < 0.0001 were considered statistically significant.  

3. Results 

3.1. Jurkat T Cells Exhibit Directional Migration Toward Force-Generating Cells on 2D Colla-

gen 

In the traditional view, the directional migration of immune cells is mainly affected 

by chemical factors, and there are few studies on the influence of mechanical factors, es-

pecially for the study of suspended immune cells to be promoted. To investigate whether 

the directional migration of suspension-like immune cells would be affected by mechanics, 

we constructed an experimental model with hASMC and A549 as force source cells capa-

ble of generating force signals on 1.0 mg/mL collagen hydrogel, and used micro-bead as 
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inert control and error comparison of collagen deformation induced by cell strains. One 

study found that macrophages were able to track cancer cells through force signals from 

collagen matrix[18], so RAW264.7 was used as a positive control, and Jurkat T was used 

as the experimental group to explore whether it is subject to mechanical regulation by the 

force-generating cell attraction.  

 

 

Figure 1. Directional migration of Jurkat T cells toward force-generating hASMCs on 2D collagen 

hydrogel. (A-C) Representative cell images and migration trajectories of Jurkat T cells, RAW264.7 

macrophages, and inert magnetic beads in co-culture with hASMCs, respectively. (D) The migration 

rate and velocity of different experimental groups, and their statistical comparisons of. (E) The prob-

ability of migration of different experimental subjects to the force-generating cells hASMC.  
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Figure 2. Directional migration of Jurkat T cells toward force-generating A549 cells on 2D colla-

gen hydrogel. (A-C) Representative cell images and migration trajectories of Jurkat T cells, 

RAW264.7 macrophages, and inert magnetic beads in co-culture with A549 cells, respectively. (D) 

The migration rate and migration velocity of different experimental groups, and their statistical 

comparisons of. (E) The probability of migration of different experimental subjects to the force-gen-

erating A549 cells. 

As shown in Figures 1A-C & 2A-C, we co-cultured Jurkat T cells (stained with 

CellTracker Red) with force-generating hASMCs (Figure 1) or A549 cells (Figure 2). 

RAW264.7 macrophages (stained with CellTracker Red) served as a positive control, and 

inert magnetic beads as a negative control. Migration was quantified within a 300-μm re-

gion centered on the force-generating cells. The results of quantitative data showed that 

Jurkat T could migrate to the force-generating cells on the 2D collagen hydrogels, similarly 

to RAW264.2 macrophages (Figures 1D & 2D). By counting the directional migrations of 

microbeads, RAW264.7 and Jurkat T within a circle of 300 μm diameter centered on the 
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force source cell, over 60% of Jurkat T cells and RAW264.7 macrophages migrated direc-

tionally toward force-generating cells, whereas fewer than 20% of beads showed directed 

movement (Figures 1E and 2E). These results confirm that suspension immune cells can 

sense and migrate toward the force-generating cells. Hence, it is speculated that the sus-

pension-like immune cells are regulated by chemical signals and mechanical signals in the 

process of participating in the immune response, which makes it more accurate to track 

abnormal cells.  

3.2. 3D Collagen Matrices Attenuate Jurkat T-Cell Directional Migration 

In order to simulate different microenvironments, the cells were encapsulated within 

1.0 mg/mL collagen hydrogel for experimental observation. The procedure was similar to 

that described above, except that the stained immune cells were mixed with the non-co-

agulated collagen and plated onto 1.0 mg/mL collagen seeded with hASMC or A549 on 

the surface, and after 15 min solidification at 37 °C, the medium was added.  

As shown in Figures 3 and 4, directional migration of Jurkat T cells toward force-gen-

erating cells was significantly reduced in 3D, accompanied by lower migration probability, 

speed, and displacement, which may be due to the existence of type I collagen in the mi-

gration process. In comparison to Jurkat T, RAW264.7 macrophages showed higher mi-

gration efficiency and probability toward force-generating cells (Figures 3D&E and 

4D&E). The impairment may result from the physical barrier imposed by dense collagen 

fibers, which are known to restrict T-cell infiltration into tumors [19].  
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Figure 3. Impaired migration of Jurkat T toward hASMC in the interior of 1 mg/mL collagen 

hydrogel. Quantitative analysis of migration probability, speed, and displacement of Jurkat T cells 

in 3D collagen matrices. hASMC was used as the force source cells, and the cells were encapsulated 

in collagen. (A-C) Experimental results and cell trajectory ensemble plots with Beads, RAW264.7, 

Jurkat T, respectively. (D) The migration rate and speed of different experimental groups, and (E) 

the probability of different experimental subjects migrating to the force-generating hASMCs.  

 

Figure 4. Representative migration trajectories of Jurkat T cells toward A549 cells in 3D collagen 

matrices. Using A549 cells as the force source, the cells were encapsulated in 1 mg/mL collagen. (A-

C) Experimental results and cell trajectory ensemble plots with Bead, RAW264.7, Jurkat T, respec-

tively. (D) The migration rate and migration velocity of different experimental groups. (E) The prob-

ability of migration of different experimental subjects to the force source A549 cells. 

3.3. Weakened Directional Migration of Jurkat T toward Force-Generating Cells on Glutaralde-

hyde-Crosslinked Hydrogel  

In order to verify whether there are mechanical factors involved in the migration 

process of T cells, the collagen surface was cross-linked and solidified to inhibit traction 
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force transmission. The 1 mg/mL collagen hydrogel was treated with 0.05% glutaralde-

hyde solution (“OHC(CH2)3)CHO”) for 15 minutes and then neutralized with Tris-HCl 

solution to restore the neutral collagen pH value, the method hereafter is the same as be-

fore. As shown in Figure 5(A-C), the experimental results showed that the probability of 

directional migration to force-generating cells was significantly reduced. These phenom-

ena indicate that the directional migration of T cells is also affected by reducing the influ-

ence of mechanical cues, which may be one of the important factors in the directional mi-

gration of T cells. As examined in our previous work, glutaraldehyde crosslinking caused 

the hydrogel stiffer [20], which could lead to enhanced random mobility of the cells.  

 

 

Figure 5. The effect of glutaraldehyde-mediated hydrogel crosslinking on Jurkat T-cell mecha-

notaxis. Experimental model of hydrogel surface after curing using glutaraldehyde cross-linking, 

and quantitative analysis and representative trajectories showing different migration after hydrogel 

crosslinking. (A, B) Ensemble plot of experimental results and cell trajectories for untreated control 

group and experimental group treated with glutaraldehyde (OHC(CH2)3CHO). (C) Probability of 

migration of Jurkat T toward force-generating hASMC cells in the control and experimental groups. 

(D) The migration rates of Jurkat T toward force-generating hASMC on 2D “Matrigel + COL” hy-

drogel in the normal and experimental groups (glutaraldehyde crosslinking, hASMC with Cyto D 

treatment, or on the glass surface coated with 1.0% of “Matrigel + COL” solution).  

In vivo environment, T cells often migrate through or crawl on basement membrane, 

one layer of matrices underneath epithelial tissues [21-23]. We also tested the mechanical 
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role in Jurkat T migration on the hydrogel matrices containing 50% Matrigel (~5 mg/mL, 

mimicking basement membrane components) and 1.0 mg/mL type I collagen (COL), as 

described in our previous work [24]. To validate the role of matrix mechanics, we stiffened 

the “Matrigel + COL” using glutaraldehyde crosslinking, or inhibited hASMC contraction 

with Cyto D treatment. As a negative control without traction force transmission through 

matrices, hASMC and Jurkat T were co-cultured on the glass surface coated with 1.0% of 

“Matrigel + COL” solution (~60 g/mL). The results showed that in comparison to the 

normal condition, the migration of Jurkat T cells was nearly abolished either after glutar-

aldehyde crosslinking of the hydrogel, or hASMC treatment with Cyto D, or on glass-

surface (Figure 5D). This result further demonstrates that dynamic matrix mechanics are 

essential for T-cell mechanotaxis in this experimental model.  

3.4. T -Cell Migration Is Modulated by the Type of Force-Generating Cells 

 

 
Figure 6. The modulation of Jurkat T migration by different types of force-generating cells. Jurkat 

T and hASMC or A549 were co-cultured on 2D collagen hydrogel, followed by time-lapse imaging 

and migration quantification. Beads and RAW264.7 groups served as inert and positive controls. (A, 

B) Quantified trajectories and migration rates of Jurkat T cells paired with hASMC or A549. (C) 

Attraction probability of Jurkat T migration toward force-generating hASMC or A549.  
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Different microenvironments may also affect the migration ability of Jurkat T. In the 

two-pair experimental groups using hASMC or A549 cells as force-generating cells (Fig-

ures 1 & 2), Jurkat T showed relatively higher migration efficiency and larger attraction 

probability in hASMC groups than in A549 groups, which difference in paired compari-

sons was demonstrated in Figure 6A-C. It is possible that different microenvironments 

also have some effect on the ability of cells to plan their routes. As reported from previous 

work this functional difference may stem from the difference in the mechanism of me-

chanical signal generation between the two cell types, with airway smooth muscle tending 

to produce sustained and stable homeostatic contractions, whereas cancer cells may ex-

hibit dynamic contractile features [25]. The way and magnitude of the force produced by 

the two types of cells is slightly different, likely attributing Jurkat T's migration ability in 

mechanotaxis. Hypothetically, the observed difference in Jurkat T migrations likely arise 

from cell-specific mechanical signaling patterns and ECM remodeling activities.  

 

4. Discussion 

Our study demonstrates that Jurkat T cells undergo robust directional migration to-

ward force-generating cells on type I collagen hydrogel, similar to macrophages, a re-

sponse not observed in inert beads. Glutaraldehyde-mediated collagen crosslinking elim-

inated this mechanotaxis, confirming that dynamic matrix mechanics are required for 

T-cell mechanosensing. These findings add new insights into the conventional view that 

immune cell migration is controlled by chemokine gradients.  

Cell-cell mechanical communications can mechanically attract direction migration of 

adhesive macrophages [26-27], while T cells under suspension growth in circulation sys-

tem were not characterized for this type of mechanical attraction. Our experiments con-

firmed that T cells on the surface of type I collagen matrix showed a remarkable charac-

teristic migration with their trajectories clearly pointing to the mechanically active target 

cells. In contrast to the negative results in the inert micro-beads group, this phenomenon 

confirms that T cell migration is mediated by cell-cell mechanical interactions. Further, 

the network of collagen fibers was solidified by glutaraldehyde crosslinking to inhibit 

long-range traction force transmission, and it was found that the directional migration of 

T cells was significantly decreased, which directly revealed that the mechanical properties 

of collagen fibers with traction force transmission is the key material basis for T cells to 

sense the mechanical signals of the microenvironment, and reducing the influence of me-

chanical factors will reduce the directional mobility. These physical properties may pre-

cisely regulate the migration behavior of immune cells through specific mechanotrans-

duction pathways.  

The divergent responses of Jurkat T migration to hASMCs and A549 cells reflect dis-

tinct mechanical microenvironments: hASMCs produce steady contractile forces, whereas 

A549 cells generate dynamic forces accompanied by MMP-2/9-dependent ECM degrada-

tion [28-30]. These distinct mechanical signals may activate different downstream path-

ways, which may provide important clues for understanding the tissue microenviron-

ment-specific mechanotransduction mechanisms, and new insights into the mechanism of 

tissue-specific mechanotransduction. It is suggested that the dynamic characteristics of 

mechanical signals may be the key factors affecting the regulation mode of cell migration 

behavior under different physiological or pathological conditions. The ability of tumor 

cells and smooth muscle cells to remodel the extracellular matrix is also very different. 

Cancer cells usually express matrix metalloproteinase such as MMP-2 and MMP-9 signif-

icantly, which can degrade collagen fibers efficiently, thus constructing a matrix stiffness 

microenvironment with gradient characteristics, while smooth muscle cells do not have 
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this ability of cancer cells [31]. This distinct remodeling mechanism may also influence the 

topological characteristics of T cell migration pathways. 

This study elucidates the universal mechanism of mechanical force perception in the 

process of immune cell chemotaxis, breaking through the theoretical framework of chem-

otactic factors dominating immune cell migration in traditional theories. This study not 

only reasonably explains the limitations of chemotactic factors in predicting the trajectory 

of immune cells in previous studies, but also provides a new perspective for understand-

ing the migration mechanism of immune cells. 

    This study innovatively reveals the causal relationship between mechanical microen-

vironment heterogeneity and T cell migration behavior, and proposes a theoretical hy-

pothesis that mechanical force heterogeneity can drive T cells to adopt differentiated mi-

gration strategies. The theory has the potential to provide innovative explanations for key 

clinical issues, and mechanical signals can also affect immune cell migration, which can 

guide immune cells to aggregate more precisely. However, in the dense microenviron-

ment, it may also lead to the dysfunction of T cell migration and then cause immune es-

cape. This study is expected to fill the important gap in the field of immunomechanics.  

5. Conclusions 

The study used live-cell imaging to Quantitative analysis that mechanical cues, in 

addition to traditional chemoattractant gradients, are also effective at directing T-cell mi-

gration at the single-cell scale. T-cell mechanotaxis is further modulated by force-generat-

ing cell type and matrix dimensionality. The study found that despite the heterogeneity 

of T cells in response to mechanical stimuli from different sources, such as lung cancer 

cells and airway smooth muscle cells, this finding revises the classical chemokine-domi-

nant model of immune cell migration and explain the impaired immune infiltration in stiff 

fibrotic and tumor stroma.  
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Intercellular Mechanical Communication Drives Directional 

Migration of Jurkat T Immune Cells

Abstract

While the mechanisms of chemokines in regulating immune responses have been 

extensively  elucidated,  the  contributions  of  biophysical  mechanical  cues  to  the 

modulation of immune cell migratory behaviors remain largely unexplored. In this 

study,  we  applied  a  modular  co-culture  system,  pairing  suspension  Jurkat  T 

lymphocytes (with RAW 264.7 macrophages as a positive migratory control) with two 

force-generating cell types—human airway smooth muscle (ASMCs) and human lung 

adenocarcinoma A549—cultured on type I collagen hydrogels, to dissect the effects 

of intercellular mechanical signals on migration of immune cells. We observed that 

Jurkat T cells exhibited directional migration toward force-generating cells on 2D 

hydrogel  surface,  with  migratory  trajectories  consistently  oriented  toward 

mechanically active target cells. Glutaraldehyde-mediated crosslinking of collagen or 

Matrigel supplemented  with  collagen, which  ablates  cell-cell mechanical 

interactions, significantly impaired directional attraction of Jurkat T, and so did with 

inhibited contraction force of ASMCs or cells seeding on glass surface, confirming 

the role of mechanotaxis in this migratory phenotype. Notably, Jurkat T migratory 
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efficiency was enhanced toward ASMCs relative to A549, a phenotype likely driven 

by cell type-specific intrinsic mechanical properties. Furthermore, 3D encapsulation 

within bulk collagen hydrogels significantly attenuated Jurkat T directional migration 

toward both force-generating cells. Collectively, our data demonstrate that T cell 

mechanotaxis  is  dually  modulated  by intrinsic  mechanical  phenotype  of  force-

generating cells and dimensionality of extracellular matrix microenvironment. These 

findings  indicate that  biophysical  mechanical  cues,  independent  of  and 

complementary to chemokine gradients, are potent regulators of directional T cell 

migration, providing new insights into the emerging field of immunomechanics.

Keywords:  immunomechanics;  cell  mechanical  communication;  directional 

migration; Jurkat T cells, mechanotaxis

1. Introduction

Cell  mechanical  communication  has  emerged  as  a  key  research  frontier, 

encompassing  cell-cell  mechanical  interactions,  cell-extracellular  matrix  (ECM) 

mechanical  crosstalks,  and  mechanosensitive  channel signaling[1-3]. These 

processes control fundamental immune functions and disease progressions. At the 

immune synapse, T cells bind to ICAM-1 (Intercellular adhesion molecule 1) of target 

cells  through  LFA-1 (lymphocyte  function-associated  antigen–1),  transmitting 
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mechanical  signals  to  enhance  immune  responses[4].  When  ECM  stiffness  is 

increased,  mechanical  tension  inhibits  the  Hippo  pathway,  promoting  YAP/TAZ 

nuclear  translocation  and  fibrotic  or  tumorigenic  gene  expression[5].  The 

mechanosensitive ion channel Piezo1 converts mechanical forces into biochemical 

signals to drive tumor angiogenesis[6]. Many mechanical signaling pathways affect 

the mechanical communication of cells.

Chemokines  are  important  regulatory  factors  in  immune  response.  In  most 

theories, the directional aggregation of immune cells depends on chemical factors, 

namely chemokines. CCL19 (C-C motif chemokine ligand-19) and CCL21 are involved 

in immune surveillance by directing T cell migration to lymph nodes through the 

receptor CCR7[7]. On the surface of endothelial cells at sites of inflammation, LFA-1 

mediates  T  cell  adhesion  and  crawling  on  blood  vessels  for  transendothelial 

migration[8]. CX3CR1,  a  receptor  for  the  chemokine  CX3CL1  (C-X3-C  motif 

chemokine  ligand-1),  plays  an  important  role  in  the  regulation  of  inflammatory 

responses,  including  monocyte  homeostasis  and  macrophage  phenotype  and 

function[9]. 

Mounting evidence indicates that immune cells are also regulated by mechanical 

cues. Fluid shear stress enhances NK cell cytotoxicity against circulating tumor cells 

through  NKG2D-dependent  mechanosensing[10].  CD8⁺  T  cells  sense  substrate 
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stiffness  via  Piezo1,  and excessive  stiffness  induces CD8⁺ T-cell  exhaustion[11]. 

Memory B cells exhibit high sensitivity to mechanical forces, whereas naive B cells 

display a threshold-dependent mechanosensory response relying on Myosin IIA and 

integrins[12]. These findings highlight the dual control of immune cells by chemical 

and mechanical signals.

Despite advances in cancer immunotherapy, the mechanistic basis underlying 

force-modulated  immune  responses  remains  poorly  defined.  Piezo1  deficiency 

alleviates lung inflammation in bacterial infection models[13]. Mechanically sensitive 

immune cells are activated to different degrees by different mechanical signals[14]. 

Some immune cells are sensitive to mechanical stimuli and matrix stiffness and thus 

affect  the  immune  response[15]. Mechanical  cancer  therapies  such  as  focused 

ultrasound (FUS) trigger immune activation through thermal and mechanical effects, 

enhancing  vascular  permeability,  T-cell  infiltration,  and  tumor  suppression[16]. 

Engineered  ultrasound-responsive  T  cells  further  highlight  the  translational 

potential  of  mechanoimmunotherapy[17]. With  the  development  of  various 

researches, mechanoimmunotherapy will become more important.

Macrophages  play  a  central  role  in  immune  responses  by  secreting 

pro-inflammatory  cytokines  (e.g.,  IL-6,  TNF-α)  to  recruit  immune  cells  to 

inflammatory foci[18]. Integrin-ECM adhesion signals initiate signaling pathways 
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that  affect  macrophage  activation[19]. Increased  matrix  stiffness  leads  to 

upregulation  of  Piezo1  expression  and  activation  of  the  mechanotransduction 

effector YAP, which regulates macrophage polarization[20]. Macrophages can track 

cancer cells via collagen-transmitted mechanical signals, likely because cancer cells 

generate mechanical cues via ECM remodeling[21]. However, whether mechanical 

signals direct the migration of suspension immune cells remains unclear.

In this study, we applied a collagen hydrogel-based model to dissect the effects of 

mechanical cues (using airway smooth muscle cells and lung cancer cells as force 

sources) on the directional migration of suspension immune cells, using Jurkat T cells 

as a paradigm and macrophages RAW264.7 as a positive control. We show  that 

mechanical cues, in addition to the traditional chemotactic factors that drive cell 

migration, are also effective in guiding T cell directional migration. These findings 

revise the classical chemokine-centric model of immune cell migration and provide a 

theoretical foundation for integrating mechanical immune regulation. 

2. Materials and Methods

2.1. Cell culture and regents

Human airway smooth muscle cells (hASMC), Jurkat T cells, human lung cancer 

cells A549, and murine macrophages RAW264.7 were purchased from BeiNa Biology. 
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All types of cells were cultured in mediums supplemented with 10% fetal bovine 

serum (FBS), 100 U/mL penicillin, and 100 g/mL streptomycin. hASMC cells were 

maintained in low glucose-type DMEM medium, Jurkat T cells in RIPM 1640 medium, 

A549 in F12 medium, and RAW264.7 in high glucose DMEM medium. Cells were 

cultured in a humidified cell incubator containing 5% CO2 at 37C.  Jurkat T was 

cultured on a mini-shaker (~20 rpm) to maintain suspension growth in the incubator.

All  cell  culture  mediums,  FBS,  Lipofectamine  3000,  and  Opti-MEM  were 

purchased from Thermo Fisher Scientific (Waltham, MA, USA). Rat type-I collagen 

was from Advanced Biomatrix and MatrigelTM from BD Biotechnology (CA, USA). 

Cytochalasin D (Cyto D) was from Sigma-Aldrich.

2.2. Constructing hydrogel model for two-type cell-cell mechanical interactions

To describe the experimental scheme, hAMSC was used as the force-generating 

cells and Jurkat T was used as the experimental immune cells. hAMSC cells had 

larger size than Jurkat T, and to further distinguish them under the microscope 

imaging, Jurkat T was stained with live cell dye CellTracker Red. All procedures were 

performed on ice. To make polydimethylsiloxane (PDMS), the two liquid components 

from the Sylgard 184 kit (Dow Corning) were well mixed at a 10:1 mass ratio in a 

petri dish followed by curing at 70°C. A PDMS mold (inner diameter ≈1 cm, outer 
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diameter ≈1.5 cm, thickness ≈2 mm) was attached onto the glass bottom of  a 

confocal dish. Rat-tail type I collagen (3.9 mg/ml) was mixed with neutralizing buffer 

in a 9:1 ratio, and diluted to 1 mg/mL with PBS solution. The prepared collagen 

solution was added into the PDMS ring by using a 10 l pipette, and spread several 

times until the inner plane of the ring was covered evenly. Then, the hydrogel model 

was incubated at 37°C for 15 min to allow gelation. 

Jurkat  T  cells  were  stained  with  CellTracker  Red: 3  mL  of  the  cells  from 

suspension culture were centrifuged, resuspended with 2 ml of serum-free RIPM 

1640 medium containing 5 μl of CellTracker Red, and then incubated in the cell 

culture incubator for 30 min. After centrifugate, cells were adjusted to 5106/ml in 

complete RIPM 1640 medium. hASMC cells were trypsinized, and diluted to 1105 

cells/mL. 20  l  hASMC cell suspension was seeded onto the collagen gel evenly 

within the PDMS ring, and then the dish was placed within a six-well holder (Karl 

Zeiss) and incubated for 1 h to allow cell attachment. Then, 20 l of stained Jurkat T 

suspension was added and incubated for another 1 h. a 1:1 mixture of RIPM 1640 

medium and low-sugar DMEM medium (10% FBS) was made for hASMC and Jurkat T 

co-culture in experiments. 2 mL of the mixture medium were added gently along the 

dish edge without disturbing the cells, and samples were subjected to time-lapse 

imaging in the live cell microscope workstation. 
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Four cell interaction pairs were tested:  Jurkat T + hASMC, Jurakt T + A549, 

RAW264.7 + hASMC, RAW264.7 + A549, by following the similar preparations. As 

inert negative controls, magnetic beads (~5 m in diameter) were added at similar 

density  to  replace  the  immune  cells.  For  3D  collagen  embedding  experiments, 

collagen  solution  (1  mg/mL)  was overlaid  on  the  collagen gels  pre-seeded with 

force-generating cells (hASMC or A549) and immune cells, followed by gelation for 

15 min and medium addition.

2.3. Glutaraldehyde crosslinking of the hydrogel

Glutaraldehyde  crosslinking  of  the  hydrogel  can  reduce  traction  force 

transmission through the matrices, which served as a negative condition in this work. 

Briefly, the 1.0 mg/mL collagen hydrogel was treated with 0.05% glutaraldehyde 

solution for 15 minutes and then neutralized with Tris-HCl solution for 1 hour, 

followed by three times of PBS buffer washings (5 min each time). The method 

hereafter is the same for two-type cell seedings. 

Alternatively, to mimic in vivo basement membrane matrices, the experimental 

condition was examined on the hydrogel of 50% Matrigel (~5 mg/mL) supplemented 

with  1.0  mg/mL type I  collagen (COL).  To  compare with  the  untreated normal 

condition, the“Matrigel + COL” hydrogel was crosslinked with 0.05% glutaraldehyde 
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solution, or the force-generating cells hASMCs were pre-treated with Cyto D (1.0 

g/mL) for 1 h to reduce cell contraction force. The co-culture of hASMC and Jurkat 

cells were also seeded on glass surface coated with 1.0 % “Matrigel + COL” diluted 

solution, as non-traction force transmission control.

2.4. Live cell microscope imaging

Time-lapse imaging was carried out on a Zeiss observer.Z1 live-cell workstation 

equipped with a temperature- and CO₂-controlled chamber (37°C, 5% CO₂). The cell 

sample dishes were placed into a six-well holder within the chamber. Images were 

acquired at 1 h intervals for 36 h. Stained Jurkat T cells were visualized using a 

Rhodamine channel.

2.5. Cell Trajectory Tracking and Analysis

Time-series images were imported into ImageJ. Scale calibration was performed 

via Analyze > Set Scale by clicking the Straight Line, and then Set Scale in the 

Analyze column to convert visual distance to real size. Cell migration was tracked 

using Plugins > Manual Tracking to generate coordinate data by using Add track 

frame by frame to obtain cell trajectory results. The digital data files were imported 

into MATLAB 2015b software to determine the move rate, velocity, trajectory, and 

travel distance as described previously (reference). 
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2.6 Statistical Analysis

Data were analyzed and plotted using GraphPad Prism, and Origin2020. Values 

are presented as mean ± standard deviation (S.D.). Student’s t-test was used for 

two-group comparisons; one-way ANOVA for multiple groups. *p < 0.05, **p < 0.01, 

***p < 0.001, and ****p < 0.0001 were considered statistically significant. 

3. Results

3.1. Jurkat T Cells Exhibit Directional Migration Toward Force-Generating Cells on 

2D Collagen

In  the  traditional  view,  the  directional  migration  of  immune  cells  is  mainly 

affected by chemical factors, and there are few studies on the influence of mechanical 

factors, especially for the study of suspended immune cells. To investigate whether 

the  directional  migration  of  suspension-like  immune cells  would  be  affected by 

mechanics, we constructed an experimental model with hASMC and A549 as force 

source cells on 1.0 mg/mL collagen hydrogel, and used micro-bead as inert control 

and error comparison of collagen deformation induced by cell strains. One study 

found that macrophages were able to track cancer cells through force signals from 

collagen matrix[21], so RAW264.7 was used as a positive control, and Jurkat T was 
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used as  the experimental  group to  explore whether  it  is  subject  to  mechanical 

regulation by the force-generating cell attraction. 
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Figure 1. Directional migration of Jurkat T cells toward force-generating 

hASMCs on 2D collagen hydrogel. (A-C) Representative cell images and migration 

trajectories of Jurkat T cells, RAW264.7 macrophages, and inert magnetic beads in 

co-culture with hASMCs, respectively. (D) The migration rate and velocity of different 

experimental groups, and their statistical  comparisons of.  (E)  The probability of 

migration of different experimental subjects to the force-generating cells hASMC. 
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Figure  2. Directional migration of Jurkat T cells toward force-generating 

A549  cells on  2D  collagen hydrogel. (A-C)  Representative  cell  images  and 

migration trajectories of Jurkat T cells, RAW264.7 macrophages, and inert magnetic 

beads  in  co-culture  with  A549  cells,  respectively.  (D) The  migration  rate  and 

migration velocity of different experimental groups, and their statistical comparisons 

of. (E) The probability of migration of different experimental subjects to the force-

generating A549 cells.

As shown in Figures 1A-C & 2A-C, we co-cultured Jurkat T cells (stained with 

CellTracker Red) with force-generating hASMCs (Figure 1) or A549 cells (Figure 2). 

RAW264.7 macrophages (stained with CellTracker Red) served as a positive control, 

and inert magnetic beads as a negative control. Migration was quantified within a 

300-μm region centered on  the  force-generating cells. The results of quantitative 

data showed that Jurkat T could migrate to the force-generating cells on the 2D 

collagen hydrogels,  similarly  to RAW264.2 macrophages (Figures 1D & 2D). By 

counting the directional migrations of microbeads, RAW264.7 and Jurkat T within a 

circle of 300 μm diameter centered on the force source cell, over 60% of Jurkat T cells 

and RAW264.7 macrophages migrated directionally toward force-generating cells, 

whereas fewer than 20% of beads showed directed movement (Figures 1E and 2E). 
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These results confirm that suspension immune cells can sense and migrate toward 

the force-generating cells. Hence, it is speculated that the suspension-like immune 

cells are regulated by chemical and mechanical signals in the process of participating 

in the immune response, which makes it more accurate to track abnormal cells. 

3.2. 3D Collagen Matrices Attenuate Jurkat T-Cell Directional Migration

In order to simulate different microenvironments, the cells were encapsulated 

within 1.0 mg/mL collagen hydrogel for experimental observation. The procedure 

was similar to that described above, except that the stained immune cells were mixed 

with the non-coagulated collagen and plated onto 1.0 mg/mL collagen seeded with 

hASMC or A549 on the surface, and after 15 min solidification at 37 °C, the medium 

was added. 

As shown in Figures 3 and 4,  directional migration of Jurkat T cells  toward 

force-generating  cells  was  significantly  reduced  in  3D,  accompanied  by  lower 

migration probability, speed, and displacement, which may be due to the existence of 

type I  collagen in the migration process. In comparison to Jurkat T,  RAW264.7 

macrophages  showed  higher  migration  efficiency  and  probability  toward  force-

generating cells (Figures 3D&E and 4D&E).  The impairment may result from the 
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physical barrier imposed by dense collagen fibers, which are known to restrict T-cell 

infiltration into tumors[22]. 
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Figure 3. Impaired migration of Jurkat T toward hASMC in the interior of 1 

mg/mL collagen hydrogel. Quantitative analysis of migration probability, speed, 

and displacement of Jurkat T cells in 3D collagen matrices. hASMC was used as the 

force source cells, and the cells were encapsulated in collagen. (A-C) Experimental 

results  and  cell  trajectory  ensemble  plots  with  Beads,  RAW264.7,  Jurkat  T, 

respectively. (D) The migration rate and speed of different experimental groups, and 

(E)  the  probability  of  different  experimental  subjects  migrating  to  the  force-

generating hASMCs. 
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Figure 4. Representative migration trajectories of Jurkat T cells toward A549 

cells in 3D collagen matrices. Using A549 cells as the force source, the cells were 

encapsulated in  1 mg/mL  collagen. (A-C)  Experimental results and cell trajectory 

ensemble plots with Bead, RAW264.7, Jurkat T, respectively. (D) The migration rate 

and  migration  velocity  of  different  experimental  groups.  (E)  The  probability  of 

migration of different experimental subjects to the force source A549 cells.

3.3. Weakened Directional Migration of Jurkat T toward Force-Generating Cells on 

Glutaraldehyde-Crosslinked Hydrogel 

In order to verify whether there are mechanical factors involved in the migration 

process of T cells, the collagen surface was cross-linked and solidified to inhibit 

traction force transmission. The 1 mg/mL collagen hydrogel was treated with 0.05% 

glutaraldehyde solution (“OHC(CH2)3)CHO”) for 15 minutes and then neutralized 

with Tris-HCl solution to restore the neutral collagen pH value, the method hereafter 

is the same as before. As shown in Figure 5(A-C), the experimental results showed 

that  the  probability  of  directional  migration  to  force-generating  cells  was 

significantly reduced. These phenomena indicate that the directional migration of T 

cells is also affected by reducing the influence of mechanical cues, which may be one 

of the important factors in the directional migration of T cells. As examined in the 
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previous work, glutaraldehyde crosslinking caused the hydrogel being stiffer[23], 

which could lead to enhanced random mobility of the cells. 

In vivo environment, T cells need migrate through basement membrane, the 

matrices underneath vascular vessels and epithelial tissues[24, 25]. We also tested 

the mechanical role in Jurkat T migration on the hydrogel matrices containing 50% 

Matrigel (~5 mg/mL, mimicking basement membrane components) and 1.0 mg/mL 

type I collagen (COL), as described in the previous work[26]. To validate the role of 

matrix  mechanics,  we  stiffened  the  “Matrigel  +  COL” using  glutaraldehyde 

crosslinking, or inhibited hASMC contraction with Cyto D treatment. As a negative 

control without traction force transmission through matrices, hASMC and Jurkat T 

were co-cultured on the glass surface coated with 1.0% of “Matrigel + COL” solution 

(~60 g/mL). The results showed that  in comparison to the normal condition, the 

migration  of  Jurkat  T  cells  was  nearly  abolished  either  after  glutaraldehyde 

crosslinking of the hydrogel, or hASMC treatment with Cyto D, or on glass-surface 

(Figure 5D). This result further demonstrates that dynamic matrix mechanics are 

essential for T-cell mechanotaxis in this experimental model. 
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Figure  5.  The effect of  glutaraldehyde-mediated  hydrogel crosslinking  on 

Jurkat T-cell mechanotaxis. Experimental model of hydrogel surface after curing 

using  glutaraldehyde  cross-linking,  and quantitative  analysis  and representative 

trajectories showing different migration after hydrogel crosslinking. (A, B) Ensemble 

plot of experimental results and cell trajectories for untreated control group and 

experimental group treated with glutaraldehyde (OHC(CH2)3CHO). (C) Probability of 

migration  of  Jurkat  T  toward force-generating  hASMC  cells  in  the  control  and 

experimental groups. (D)  The migration rates of Jurkat T toward force-generating 

hASMC on 2D “Matrigel + COL” hydrogel in the normal and experimental groups 

(glutaraldehyde crosslinking, hASMC with Cyto D treatment, or on the glass surface 

coated with 1.0% of “Matrigel + COL” solution). 

3.4. T -Cell Migration Is Modulated by the Type of Force-Generating Cells

Different microenvironments may also affect the migration ability of Jurkat T. In 

the two-pair experimental groups using hASMC or A549 cells as force-generating 

cells (Figures 1 & 2), Jurkat T showed relatively higher migration efficiency and 

larger attraction probability in hASMC groups than in A549 groups, which difference 

in paired comparisons was demonstrated in Figure 6A-C. It is possible that different 

microenvironments also have some effect on the ability of cells to plan their routes. 
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This  functional  difference  may  stem  from  the  difference  in  the  mechanism  of 

mechanical signal generation between the two cell types, as ASMC expressing both 

-smooth muscle actin tends to produce active contractions, whereas lung epithelial 

cancer cells expressing only -actin exhibit passive tensions[27, 28]. The way and 

magnitude of the force produced by the two types of cells is slightly different, likely 

attributing Jurkat T's migration ability in mechanotaxis. Hypothetically, the observed 

difference in Jurkat T migrations likely arise from cell-specific mechanical signaling 

patterns and ECM remodeling activities. 
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Figure  6.  The  modulation  of  Jurkat  T migration  by  different types of 

force-generating  cells.  Jurkat T and hASMC or A549 were co-cultured on 2D 
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collagen hydrogel,  followed by time-lapse  imaging and migration quantification. 

Beads and RAW264.7 groups served as inert and positive controls. (A, B) Quantified 

trajectories and migration rates of Jurkat T cells paired with hASMC or A549. (C) 

Attraction probability of Jurkat T migration toward force-generating hASMC or A549. 

4. Discussion

Our study demonstrates that Jurkat T cells undergo directional migration toward 

force-generating  cells  on  type  I  collagen hydrogel,  similar  to  macrophages,  a 

response  not  observed  in  inert  beads.  Glutaraldehyde-mediated  collagen 

crosslinking  weakened  this  mechanotaxis,  confirming  that  dynamic  matrix 

mechanics are required for T-cell mechanosensing. These findings add new insights 

into the conventional view that immune cell migration is regulated by chemokine 

gradients. 

Cell-cell  mechanical  communications  can  attract  directional  migration  of 

adhesive macrophages[29], while T cells under suspension growth in circulation 

system  were  not  characterized  for  this  type  of  mechanical  attraction.  Our 
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experiments confirmed that T cells on the surface of type I collagen matrix showed a 

characteristic migration with their trajectories clearly pointing to the mechanically 

active target cells. In contrast to the negative results in the inert micro-beads group, 

this phenomenon confirms that T cell migration is mediated by cell-cell mechanical 

interactions. Further,  the  network  of  collagen  or  the  mixed  ‘Matrigel  +  COL’ 

hydrogel was solidified by glutaraldehyde crosslinking to inhibit long-range traction 

force transmission, and it was found that the directional migration of T cells was 

significantly  decreased,  and  so  did  with  Cyto  D-inhibiting  active  contraction  of 

hASMCs or cells seeding on hard glass (Figure 4A-C). These results revealed that the 

mechanical properties of collagen fibers with traction force transmission is the key 

material basis for T cells to sense the mechanical signals of the microenvironment. 

The divergent responses of Jurkat T migration to hASMCs and A549 cells reflect 

distinct mechanical microenvironments: hASMCs produce active contractile forces, 

whereas A549 cells generate passive tension forces. Additionally, the ability of tumor 

cells and smooth muscle cells to remodel the extracellular matrix is also different. 

Cancer cells usually express matrix metalloproteinase such as MMP-2 and MMP-9, 

which  can  construct  a  matrix  stiffness  microenvironment  with  gradient 

characteristics, while smooth muscle cells do not have this ability of cancer cells[30-
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32]. This  distinct  remodeling  mechanism  may  also  influence  the  topological 

characteristics of T cell migration pathways.

This study elucidates the universal mechanism of mechanical force perception in 

the process of  immune cell  chemotaxis,  which not only reasonably explains the 

limitations of chemotactic factors in predicting the trajectory of immune cells, but 

also provides a new perspective for  understanding the migration mechanism of 

immune cells.  However, in the dense microenvironment, it may also lead to the 

dysfunction of T cell migration and then cause immune escape. This study is expected 

to fill certain gap in the field of immunomechanics. 

Conclusion: The study used live-cell imaging and quantitative analysis to discover 

that mechanical cues, in addition to traditional chemoattractant gradients, are also 

effective at directing T-cell migration at the single-cell scale. T-cell mechanotaxis is 

further modulated by force-generating cell  type and matrix dimensionality.  This 

finding revises the classical chemokine-dominant model of immune cell migration 

and implicates the impaired immune infiltration in stiff fibrotic and tumor stroma. 
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